For bibliographic references, \LaTeX{} uses the \BibTeX{} database system. In this session we shall:

1. compile an existing document with bibliographic references; see section 1.2. Both the document and the bibliographic database are included in this session's set of practice files.
2. convert a fragment of a Wikipedia page to \LaTeX{} with \BibTeX{} citations and references, using a provided bibliographic database; see also section 1.2.
3. convert the provided example file above to to \natbib{}-style author-year references (section 2.2) and add new \cite{} commands. Do the same later with biblatex, which in addition supports citing by title and by url (section 2.5).
4. create or add to a \BibTeX{} database; see sections 3 and 3.9.

The required files are in this session's zipfile 3bibtex.zip.

\section{The why and how of \BibTeX{}}

Different journals have different requirements for bibliographic references:

» What to include, in what order
» Capitalization
With a bibliography manager you can maintain a single database of bibliographic references and have it generate the references for your paper in the required format.

Below a very short \LaTeX source which references entries from an existing \BibTeX database (you can find the full \BibTeX entries on page 7):

\begin{verbatim}
\documentclass{article}
\bibliographystyle{plain}
\begin{document}
See \cite{lcompanion} and \cite{biboostrum}.
\bibliography{bibdemo} % this line specifies bibdemo.bib as database
\end{document}
\end{verbatim}

As you can guess, lcompanion and biboostrum are keys of database entries:

@Article{biboostrum,
    author = "Piet van Oostrum",
    title = "Een tutorial over het gebruik van \{Bib\(\TeX\}\)",
    year = 2004,
    ...}
@Book{lcompanion,
    Author = "Frank Mittelbach and Michel Goossens",
    Title = "The \LaTeX Companion",
    year = 2004,
    ...}

We get the following output:

See [1] and [2].

\begin{center}
\begin{tabular}{|l|}
\hline
\textbf{References} \\
\hline
\hline
\end{tabular}
\end{center}

You can put the \texttt{\bibliographystyle} command anywhere before the \texttt{\bibliography} command.\footnote{\LaTeX used to be more restrictive in this respect. Therefore, many old-time \LaTeX users still place the \texttt{\bibliographystyle} command right before the \texttt{\bibliography} command.}

Bibliography styles are provided by .bst files: plain.bst in the example above, alpha.bst in the example from section 2.1, both hidden deep inside the \TeX Live directory structure.

Once you have prepared your \LaTeX source and your \BibTeX database, you need to take the following steps:

1. Run \texttt{pdflatex} to generate the information that \BibTeX needs
2. Run \texttt{bibtex} to generate the list of references
3. Run `pdflatex` to include the list of references
4. Run `pdflatex` yet again to resolve bibliographic references (just like other cross-references)

TeXstudio has a `bibtex` command in the Tools menu. You can also use keyboard shortcuts: F6, F11, F6, F6. Note that after further editing a single `pdflatex` run is enough as long as the list of references stays the same.

1.1 `nocite`: entries without citations
You can use `\nocite` instead of `\cite` if you don’t want an automatically generated citation in the running text but do want an entry in the list of references:

```latex
\nocite{lcompanion}
```

Tip. You can quickly create a formatted printout of your Bib\TeX database with the `\nocite{}` command (see `testbib.tex` from the practice files):

```latex
\documentclass{article}
\bibliographystyle{plain}
\begin{document}
\nocite{ }
\bibliography{your_bibtex_file}
\end{document}
```

1.2 Practice
1. Run the `bibdemo` example: after unpacking the practice files in a suitable folder, load `bibdemo.tex` in TeXstudio. Then carry out the four steps listed on page 2.
2. Try to recreate `Factors_refs.html` from the practice files as a \LaTeX file with proper `cite` commands and a proper list of references. Use the `factors.bib` bibliography database.

2 Bibliography styles: three generations

2.1 The original Bib\TeX
The original Bib\TeX from 1988 uses a simple citation style: the entries in the list of references get an automatically generated label – either numerical or alphanumerical – for cross-referencing. We already saw numerical references. Here is an example with alphanumerical labels:

```latex
\documentclass{article}
\bibliographystyle{alpha}
\begin{document}
\nocite{ }
\bibliography{bibdemo}
\end{document}
```

See `\cite{lcompanion}` and `\cite{biboostum}`.

```latex
\bibliography{bibdemo}
\end{document}
```

See [MG04] and [vO04].

References


2.2 The next step: author – Year citation styles

The classical bibliography styles didn’t provide for author – year citation styles, such as in the examples below:


References


or, with a different bibliography style:


References


Note the absence of labels in the list of references.

Author-year citation styles are provided by the natbib package and by various alternatives such as the apalike and harvard packages. natbib is the most popular one and can replace most of the others. This is the \LaTeX{} preamble code:

\begin{verbatim}
\usepackage{natbib}
\bibliographystyle{chicago} % first example
%\bibliographystyle{apsrev} % second example
\end{verbatim}

Cite commands in the running text:

See \cite{castaldo2006} from \citeyear{castaldo2006} and \cite{texbook}.

A sample of citation commands supported by natbib:

\begin{verbatim}
\cite{tamethebeast} Markey, 2005
\citep{tamethebeast} Markey (2005) ‘in-text’
\citet{tamethebeast} (Markey, 2005) ‘parenthesized’
\citet[noted]{lshort} Oetiker et al. (2011, noted)
\citep*[lshort]{lshort} (Oetiker et al., 2011)
\citeauthor{tamethebeast} Markey
\citeyear{lshort} 2011
\end{verbatim}

\nocite works as usual.

See the natbib manual for more variations and for customization options.

2.3 Practice

Try out natbib-style citations on a copy of bibdemo.tex.
2.4 Generating your own bibliography style with custom-bib/makebst

Journals sometimes have very specific requirements as to the formatting of bibliographic entries, without providing a bibliography style implementing this formatting. Even if a suitable style exists, it may be hard to find one, although the UK \TeX FAQ has to offer some advice. One way out is creating your own \texttt{.bst} file.

If a style is almost correct, and if you can make some sense out of \texttt{.bst} files (a big if!), then maybe you can fix it yourself.

Another option is the \texttt{makebst} program. This is a two-step process: in the first step, you have to answer a very long list of questions. Your answers are written to an intermediate answers file. In the second step, a \texttt{.bst} file is generated from this list of answers. See the documentation of makebst for details, e.g. file-search for makebst in texdoctk.

However, the process is too involved and time-consuming to practice in this course.

2.5 The latest and greatest: biblatex

A radical reimplementation of bibliography support is biblatex. Bibliography styles aren't written in the unfamiliar \texttt{.bst} syntax but in \LaTeX, and the role of \texttt{BibTeX} is reduced to collecting and sorting the bibliographic data. \LaTeX itself selects, arranges and formats the fields of the bibliographic entries. Advantages include

» many variations in bibliography style can be realized simply with package options, without editing \texttt{.bst} files
» better support for non-Western languages
» more citation options, because \LaTeX has access to all the bibliographic information
» easy per-chapter bibliographies

Fortunately, an old \texttt{BibTeX} database is still compatible with biblatex.

Getting started with biblatex. You can easily experiment with biblatex. If you include a package option \texttt{natbib} or \texttt{natbib=true} then you can keep using \texttt{natbib} cite commands in your \LaTeX source.

You should also configure TeXstudio to use biber instead of \texttt{BibTeX} (\texttt{Options / Configure TeXstudio / Build / Default Bibliography}), or alternatively load biblatex with an option \texttt{backend=bibtex}.

Below biblatex preamble commands, assuming biber as backend; note that with biblatex the \texttt{\bibliography} command should be in the preamble:

```latex
\usepackage[style=numeric]{biblatex}
\bibliography{bibdemo}
```

And near the end:

```latex
\printbibliography
```

The complete source for the first example:

```latex
\documentclass{article}
\usepackage[style=numeric]{biblatex}
\bibliography{bibdemo}
\begin{document}
See \cite{lcompanion} and \cite{bacgri2003}.
\end{document}
```

Output:
See [2] and [1].

References


An example with author-year citations and the new \citetitle command:

\documentclass{article}
\usepackage[bibstyle=authoryear,block=ragged]{biblatex}
\bibliography{bibdemo}
\begin{document}
See \citetitle{lcompanion} by \citeauthor{lcompanion} published in \citeyear{lcompanion}.
\printbibliography
\end{document}

References

Mittelbach, Frank and Michel Goossens (2004). The \LaTeX\ Companion. 2nd. Addison-Wesley.

By now, there are quite a few biblatex styles (search for ‘biblatex-’ in the CTAN Catalogue), and existing styles can be tweaked with options. Still, it is conceivable that none of the existing styles are usable. And there is no makebst (section 2.4) for biblatex. It is also possible that the recipient has an antiquated \TeX setup and is not willing or not able to handle biblatex. So it is too soon to assign the older solutions to the dustbin.

2.6 Practice

Modify a copy of \texttt{bibdemo.tex} to make use of biblatex and the \citetitle command.

3 The Bib\TeX database format

This section describes the Bib\TeX database format. Like a \LaTeX source, a Bib\TeX database is a plain text file. It has an extension .bib, and consists of a series of records such as the following:

\begin{verbatim}
@Article{biboostrum,  
  author = "Piet van Oostrum", 
  title = "Een tutorial over het gebruik van \{Bib\TeX\}"
  journal = "\{MAPS\}", 
  volume = "30", 
  pages = "66--86", 
  year = 2004, 
}

@Book{lcompanion,  
  Author = "Frank Mittelbach and Michel Goossens", 
  Title = "The \{\LaTeX\}\ Companion",
\end{verbatim}
3 The BibTeX database format

Publisher = AW,  
year = 2004,  
Edition = "2nd", 
}

Note the general structure: a BibTeX record consists of:

» The type of publication, e.g. article or book
» A key, e.g. bipoosrutm or lcompanion, which is used for citing
» A list of fields

The list of required and optional fields varies with the entry type. You can add additional fields, e.g. as comments for yourself. Any field which is not required or optional will simply be ignored.

For most fields, the values should be enclosed in braces { and }, or in double quotes " ". Values which are clearly numbers, such as years and volume numbers, may be entered ‘bare’.

You should enclose LaTeX code in an additional set of braces to keep BibTeX from messing with it. You should do the same with all-caps words.

As to accented characters: the safe solution is always to use macros: \{"e\} rather than é, although with care or luck accented letters may work ok; see section 3.4.

3.1 BibTeX editors

For creation and maintenance of your BibTeX database you should pick a program that uses BibTeX as its native format. Our TeX Live installation includes JabRef, which is a Java application and therefore available on all platforms. On Mac OS, BibDesk is a popular choice.

Editing manually with your LaTeX editor is another good option.

3.2 Using online resources

Often, you do not need to create entries from scratch. There are various online resources which can export bibliographic entries in BibTeX format. A popular option is Zotero, which is a Firefox extension and a reference manager in its own right.

Zotero created the entry below from the Amazon page about a book and exported it to BibTeX format (click the ‘save to Zotero’ icon in the Firefox address field):

@book{voss_lax,  
title = {Latex Quick Reference},  
isbn = {1906860211},  
publisher = {Uit Cambridge Ltd.},  
avtor = {Voss, Herbert},  
month = sep,  
year = {2011}  
}

http://lead.to/amazon/ is another service which creates BibTeX records from Amazon pages.

If you have an ISBN number for a book, you can go to http://ottobib.com/ to get a BibTeX record.

The university offers access to RefWorks. However, its BibTeX support leaves something to be desired.

See also http://tex.stackexchange.com/questions/143/ for more suggestions from users on where and how to get ready-made BibTeX records.

You should always double-check imported entries when you add them to your database. The tag may be just a database index number, fields or field values may be nonsensical, or there may be syntax errors.
3.3 Examples

Now let us have a more in-depth look at the BibTEx database format, by looking at a series of examples.

@TECHREPORT{canond2003,
author = "Marcel Canoy and Sander Onderstal",
year = 2003,
title = "Tight oligopolies: {I}n search of proportionate remedies",
number = 29,
institution = "{CPB} Netherlands Bureau for Economic Policy Analysis",
address = "The Hague",
}

TECHREPORT is the type of the publication. Capitalization is not significant in BibTEx entry types and field names.

The key canond2003 is used by the various cite commands.
{CPB} is enclosed in braces to protect it against BibTEx's automatic capitalization.

Also notice the author field: this consists of two authors, each in first last format. The names are separated with ‘and’.

3.4 Example: brace delimiters, alternate author syntax, accented letters

@Misc{clementsgalvao2001,
author = {Clementz, Michael P. and Galv\text{\-}o, Ana Beatriz},
title = {A comparison of tests of non-linear cointegration with an application
}
to the predictability of {US} interest rates using the term structure},
year = 2001,
howpublished = {Mimeo, Department of Economics, University of Warwick},
}

This example encloses values in braces rather than double quotes. This makes it possible to use values which include double quotes (nesting braces within braces is never a problem). The author field uses the alternate syntax of \textit{last, first}. The \textsc{Bib\TeX} manual (Patashnik (1988)) has more to say about the parsing of author’s names.

Note that this entry has a different set of fields. The bibliography style determines which entry types are recognized and which fields are required or optional for each entry type. Again, braces around \textsc{US} ensure that \textsc{Bib\TeX} leaves capitalization alone.

**Accented characters.** The above example includes a macro for an accented letter inside braces: \texttt{\~a}. You can use accented letters outright, but it requires care: make sure that the encoding, probably either latin1 or utf8, matches the \LaTeX{} source, and that you include a preamble command

\begin{verbatim}
\usepackage[enc]{inputenc}
\end{verbatim}

where \texttt{enc} should usually be utf8 or latin1. Or you can use one of the modern \LaTeX{} engines \textsc{XeLaTeX} or \textsc{LuaLaTeX}, which always expect utf8.

### 3.5 Example: a predefined abbreviation and a dummy field

\begin{verbatim}
@string{AW = "Addison-Wesley"}
...
@Book{lcpanion,
  Author = "Frank Mittelbach and Michel Goossens",
  Title = "The \LaTeX{} Companion",
  Publisher = AW,
  year = 2004,
  Edition = "2nd",
  ignorablefield = "too fat for my backpack",
}
\end{verbatim}

You can define abbreviations with @string entries. You can also create a .bib file with @string entries, and load it before the actual database file.

This entry also uses a dummy field ignorablefield for private information.

### 3.6 Example: author names with a ‘von’ part; number ranges

\begin{verbatim}
@article{meycra2004,
  author = {Meyer, Jochen and von Cramon-Taubadel, Stephan},
  title = {Asymmetric Price Transmission: A Survey},
  year = 2004,
  journal = {Journal of Agricultural Economics},
  volume = 55,
  number = 3,
  pages = {581-611},
}

@inproceedings{ricejava,
  author = "Istiqomah Istiqomah and Manfred Zeller and Stephan von Cramon-Taubadel",
  title = "Volatility and Integration of Rice Markets in Java, Indonesia",
}
\end{verbatim}

Fall 2012
These examples feature an author’s name with a ‘von’ part, first in von last, first syntax, then in first von last syntax. Again, Patashnik (1988) explains handling of author’s names.

Also note that Bib\TeX will expand the range 581–611 to 581--611, producing a proper n-dash in the typeset output.

You can read a full description of the .bib format in the original Bib\TeX documentation, Patashnik (1988). This documentation doesn’t cover extensions from e.g. the Natbib- and biblatex packages and corresponding bibliography styles.

3.7 The url field

Some bibliography styles, including styles created with makebst/custom-bst, support an url field. It is even required for the biblatex online entry type. It is a good idea to load the url package, to make sure that special characters such as underscores and tildes are rendered correctly, and to enable line-breaking inside the url. LaTeX source:

\documentclass{article}
\usepackage{natbib}
\bibliographystyle{plainnat}
\usepackage{url}
...
\nocite{biboostrum}
\bibliography{bibdemo}
\end{document}

Bib\TeX entry:

@Article{biboostrum,
  author = "Piet van Oostrum",
  title = "Een tutorial over het gebruik van {Bib\TeX}",
  journal = "{MAPS}"
  volume = "30",
  pages = "66--86",
  year = 2004,
  url = "http://www.ntg.nl/maps/pdf/30_15.pdf",
}

results in:


3.8 Urls in other fields

If the bibliography style doesn’t use an url field, you can include an url in another field. ‘How-published’ is a good option, but only in combination with e.g. the Misc entry type, since it is ignored by most other entry types. Alternatively, the ‘Note’ field is supported by almost all entry types.

@Manual{tamethebeast,
  author = "Nicolas Markey",
  title = "Tame \{t\}he \{BeaST\}, The B to X of \{Bib\TeX\}"
  year = 2005,
}

@Misc{some,
4 Troubleshooting

4.1 Random things to try

Rerun \LaTeX{}. Maybe you just need another \LaTeX{} run to resolve the \cite commands.

Problems with old auxiliary files. Sometimes it helps to start with a clean slate by getting rid of old auxiliary files: click on ‘Clean’ on the Tools menu and start over with F6, F11, F6, F6. This may be necessary if an error or incompatibility in one of the auxiliary files prevents \LaTeX{} from continuing. An incompatibility may arise if you change something in the bibliographic options.

Input encoding. Maybe there is a mismatch between the encoding of the \BibTeX{} database and the \LaTeX{} source. Add a line in the \LaTeX{} preamble

\usepackage[utf8]{inputenc}

or

\usepackage[latin1]{inputenc}

or, if there is already such a line, change ‘latin1’ into ‘utf8’ or vice versa.
4.2 JabRef

Make sure you run only one copy of JabRef. In particular, do not load one Bib\TeX\ X file into two copies of JabRef, which can easily happen.

Click File / Save database to make sure that \texttt{biblatex} or biber gets up to date information.

4.3 Get more information

In TeXstudio, try to get more detailed information, e.g. by clicking on the error tab of the tabbed pane under the edit area.

Log files can also be useful, but often contain masses of useless gibberish. The above-mentioned tabbed pane also has a tab for the \LaTeX\ \texttt{log}, but not for the \texttt{biblatex} log, which may be more useful. You can load the \texttt{biblatex} log into TeXstudio anyway: click on File > Open. Make sure that ‘Files of type’ is set to ‘All files(*)’ and then select \texttt{filename.blg}, assuming that the \LaTeX\ file is called \texttt{filename.tex}. Another file to look at is \texttt{filename.aux}.

References

\textit{BibDesk}. GUI bibliography manager for the Mac. \url{http://bibdesk.sourceforge.net/}.

\textit{CTAN Catalogue}. \url{http://mirror.ctan.org/help/Catalogue/brief.html}.

Fairbairns, Robin, ed. \textit{UK \LaTeX\ FAQ}. \url{http://faq.tug.org/}.

\textit{Google Scholar}. \url{http://scholar.google.com/}.

\textit{JabRef}. GUI bibliography manager written in Java. \url{http://jabref.sourceforge.net/}.

Lehman, Philipp (2012). \textit{The biblatex Package}. Published as part of the \texttt{biblatex} package.


Oetiker, Tobias et al. (2011). \textit{The Not So Short Introduction to \LaTeX\ 2\epsilon}. Included in most free \LaTeX\ distributions. \url{http://mirror.ctan.org/info/lshort/}.


Patashnik, Oren (1988). \textit{BibT\textsc{e}Xing}. Included in most \LaTeX\ distributions.

\textit{RefWorks}. Web-based reference manager. \url{http://www.refworks-cos.com/}.


\textit{Zotero}. Firefox extension for collecting and managing references. \url{http://www.zotero.org/}.

Siep Kroonenberg

N dot S dot Kroonenberg at rug dot nl